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Section 1: Introduction 

Microdeletions of the Y chromosome are the second most frequent genetic 

cause of spermatogenetic failure in infertile men after Klinefelter syndrome. The 

molecular diagnosis of Y chromosomal microdeletions is routinely performed in 

the workup of male infertility in men with azoospermia or severe 

oligozoospermia (M. Simoni et al., 2004). 

The portion of the male-speciýc region of the Y chromosome (MSY), comprising 

95% of the Y chromosome and þanked by pseudoautosomal regions (Skaletsky 

et al., 2003), which is affected by deletions, has been classically subdivided into 

four regions called AZFa, AZFb, AZFc and proximal AZFc (AZFd), respectively.    

Microdeletions are relatively frequent among infertile men, although the 

incidence can vary considerably depending on the selection criteria of the 

patients. Azoospermic men have a higher incidence of microdeletions than 

oligozoospermic men and consequently the deletion frequency found in different 

laboratories may vary from 2 to 55% (or even higher), reþecting the composition 

of the study population. 

The AZFa region is about 1100 kb long and contains the single copy genes 

DFFRY (or USP9Y) and DBY. In any case the complete deletion of the AZFa 

region removes about 792 kb including both USP9Y and DBY genes, the only 

two genes in AZFa. Deletions involving only the USPY9 gene or the DBY gene 

have been reported only by one group (Ferlin et al., 1999; Foresta et al., 2000). 

The type and mechanism of deletions of the AZFb and AZFc region have been 

recently clariýed as well (Kuroda- Kawaguchi et al., 2001). Both regions together 

comprise 24 genes, most of which present in multiple copies for a total of 46 

copies.  

The complete deletion of AZFb removes 6.2 Mb (including 32 copies of genes 

and transcription units) and results from homologous recombination between 

the palindromes P5/proximal P1 (Repping et al., 2002).  

The AZFc region includes 12 genes and transcription units, each present in a 

variable number of copies making a total of 32 copies (Repping et al., 2003). 

The classical complete deletion of AZFc, the most frequent pattern among men 

with deletions of the Y chromosome, removes 3.5 Mb, originates from the 

homologous recombination between amplicons b2 and b4 in palindromes P3 

and P1 respectively and removes 21 copies of genes and transcription units 

(Kuroda-Kawaguchi et al., 2001).  
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Section 2: Product Overview 

Description of Test 

This system consists of 14 primer pairs that are homologous to previously 

identified and mapped sequence-tagged sites (STS). Y chromosome deletions 

in the regions that are amplified by these primer sets have been associated with 

male infertility. This system uses a five-dye fluorescent system for automated 

DNA fragment analysis, which allows multiplex amplification and 

electrophoresis of over 14 STS which include AMXY marker (Chr.X 104bp, 

Chr.Y 109bp; Xp22.1, Yp11.2) simultaneously. The kit is intended for use on 

Applied Biosystems ABI PRISMÈ genetic analysis instrumentation. 

Fluorochromes include FAM, JOE, ATTO550 and ATTO565, to be used in 

conjunction with GeneScan 500 LIZÊ size standard (Applied Biosystems PN 

4322682). 

The Y-Del Primer Mix includes a primer pair to amplify chromose-specific 

sequences of the paralogous gene Amelogenin, which has a high degree of 

sequence identity between chromosomes Chr.X and Chr.Y. However nucleotide 

differences occur within each locus and can be used to generate chromose-

specific PCR product. The primer pair included in the Y-Del Primer Mix exploits 

a 5bp deletion (Chr.X 104bp, Chr.Y 109bp; Xp22.1, Yp11.2) to generate one 

Chr.X-specific product that is 5bp shorter than the corresponding product on Y 

chromosome.   

Although the Y Chromosome Microdeletion Detection Kit has been designed for 

the detection of microdeletions occurring on the q-arm of the Y chromosome, 

relative quantification between Chr.X and Chr.Y allows assessment of 

Klinefelter syndrome, the most significant factor in male infertility. However, 

comparative assessment of the AMXY marker cannot be used for the stand-

alone diagnosis of Klinefelter syndrome. Further investigations are necessary 

for precise diagnosis.   

Control primer pairs are internal controls for the amplification reaction and the 

integrity of the genomic DNA sample. The Primer Mix includes a primer pair that 

amplifies a region of the SRY gene. This is a control for the testis determining 

factor on the short arm of the Y chromosome and allows detection of XX males 

arising from Y to X translocations. 

The Y Chromosome Microdeletion Detection Kit has been extensively tested for 

reproducibility and robustness, and quality controlled to ensure optimum 

performance. The system incorporates controls to ensure performance of the 
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amplification reagents and to identify problems with genomic DNA samples. A 

positive control Male Genomic DNA is included for use in evaluating the 

amplification reactions. The presence of the appropriate amplification products 

in the positive control reactions indicates that the reagents are performing as 

expected. 

With the GML Y Chromosome Microdeletion Detection Kit, 14 markers are 

performed successfully. Of those, 6 markers (Sy84, Sy86, Sy127, Sy134, 

Sy254, and Sy255) are determined by European Molecular Genetics Quality 

Network guidelines. The remaining 6 are markers for all regions and so verify 

the Detection Kit in addition to control markers (SRY and AMXY).   

STS included in the Y Chromosome Microdeletion Detection Kit 

Marker Region bp Dye 

SRY(Y14) Control 464 JOE 

Sy255 AZFc 123 JOE 

Sy134 AZFb 303 JOE 

AMXY Control Chr.X 104 Chr.Y 109 FAM 

RBMY  RBMY 238 FAM 

AZFa AZFa(Prox2) 217 FAM 

Sy133 AZFb 176 FAM 

Sy153 AZFd 136 FAM 

Sy152 AZFd 124 ATTO565 

Sy157 AZFc 291 ATTO565 

Sy84 AZFa 330 ATTO565 

Sy254 AZFc 382 ATTO565 

Sy86 AZFa 317 ATTO550 

Sy127 AZFb 271 ATTO550 

Fragment sizes may vary up to 3 bp depending on the instrument and 

electrophoresis conditions employed. Sizes in this table have been obtained on 

an ABI 3130xL Genetic Analyser using the 36cm capillary array, POP7 polymer, 

FragmentAnalysis_36_POP7_1 default module and G5 Dye Set. 
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Performing the Test 

The Y Chromosome Microdeletion Detection Kit contains all necessary reagents 

for the amplification of human genomic DNA. 

The reagents are designed for use with the following Applied Biosystems 

instruments: 

Å ABI PRISMÈ 3100/3100-Avant Genetic Analyzer 

Å Applied Biosystems 3130/3130xl Genetic Analyzer 

Å Applied Biosystems 3500/3500xl Genetic Analyzer 

Å Applied Biosystems 310 Genetic Analyzer 

Å GeneAmpÈ PCR System 9600 or 9700  

Laboratory Design and Organization 

Special consideration should be given to the design and organization of the 

laboratory. The laboratory must be organized so that the area in which ampliýed 

DNA is handled is physically isolated from the work areas for DNA extraction 

and PCR setup. Strict physical isolation must be maintained between the area 

designated for handling ampliýed DNA and the other areas, to avoid transfer of 

ampliýed DNA out of the designated work area. 

Ampliýed DNA or equipment and supplies used to handle ampliýed DNA should 

not be taken out of the designated work area. If the work area for ampliýed DNA 

is in a separate but contiguous room, make sure that air þows toward the 

ampliýed DNA area. In addition, it is helpful if there is a separate exit from the 

ampliýed DNA work area that does not exit into the pre-PCR work areas. 

The laboratory should have four designated Work Areas, each ideally 

equipped with dedicated equipment and supplies to minimize the potential for 

contamination: 

1. Evidence Handling Work Area: Pieces of evidence are examined, 

photographed, and divided for analysis. 

2. DNA Extraction Work Area: This work space is used to perform the extraction 

steps. 

3. PCR Setup Work Area: PCR reagent and DNA sample additions are made 

here. 

4. Ampliýed DNA Work Area: This area is dedicated to PCR ampliýcation and 

detection, and other activities that require handling of ampliýed DNA. 
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Workflow Overview 
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Perform Electrophoresis 
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Section 3: Materials, Safety Warnings and Precautions 

Kit Contents 

Component Description 25 X Volume Storage 

Y-DEL PCR Mix 
Contains salts, dNTPs and glycerol.  

300 ÕL -20 oC 

GML Taq. Pol. Contains enzyme (5U/ÕL). 15 ÕL -20 oC 

Y-DEL Primer Mix 

Contains forward and reverse primers 

to amplify human Y-Chromosome 

targets. 

300 ÕL -20 oC 

Control DNA Contains 10 ng/ÕL human male DNA. 30 ÕL -20 oC 
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Safety Warnings and Precautions 

Please be sure to observe the following warnings. 

                  Warning                                                  Caution

1. For research use only. 

2. Not for diagnostic purpose. 

3. Use appropriate laboratory 

practices for sample handling. 

4. Wear protective disposable 

gloves and eye protection when 

handling diluents and human 

DNA. 

5. Wash hands properly after 

handling diluents and human 

DNA. 

6. Use recommended materials, 

procedures, and equipment only. 

7. Do not eat, drink or smoke in work 

areas.  

8. Use sterile disposable pipettes 

and filtered pipette tips. 

9. Do not mix reagents from different 

lots. 

10. Do not use more or less than the 

required volumes of reagents. 

11. Do not use any expired reagents. 

12. To reduce the risk of 

contamination, the area where 

amplified DNA is handled must 

be physically isolated from the 

work areas for sample 

preparation and PCR setup. 

13. Store the fluorescent dye labeled 

reagents in the dark <-15 oC.  

14. Open and close all sample tubes 

or wells carefully to avoid 

splashing or spraying.  

15. Minimize the exposure of Hi-Di 

Formamide to the air and do not 

contaminate Hi-Di Formamide 

when sampling. 

16.   Chemical Hazard. Pop-7 

polymer causes eye, skin, and 

respiratory tract irritation. It is a 

possible reproductive and birth 

defect hazard. Please read the 

Applied Biosystems MSDS and 

follow the handling instructions. 

Wear appropriate protective 

eyewear, clothing, and gloves. 

17.   Chemical Hazard. 

Formamide causes eye, skin, and 

respiratory tract irritation. It is a 

possible reproductive and birth 

defect hazard. Please read the 

Applied Biosystems MSDS and 

follow the handling instructions. 

Wear appropriate protective 

eyewear, clothing, and gloves.  
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Shipping Conditions 

The GML Y CHROMOSOME MICRODELETION DETECTION KIT is shipped 

on ice packs and should still be frozen on arrival.  

Avoid unnecessary freeze-thawing of the contents of the kit. 

 

Storage and Handling Requirements 

Fluorescent primers should be stored away from light. The GML Y Chromosome 

Microdeletion Detection Kit box is internally coated to increase light protection. 

This kit is stable for up to one year if stored at -20 ÜC. PCR and primer mixes 

can be stored as ready to use aliquots in PCR tubes at -20 ÜC; this will keep 

freeze-thaw cycles to a minimum reducing the risk of contamination and 

shortening PCR set-up times. 
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Section 4: Y Chromosome Microdeletion Detection Kit 

Procedure 

Preparing Genomic DNA Template 

1. Prepare genomic DNA according to standard protocols. 

2. Determine the concentration by A260 or fluorescence.  

3. The amount of DNA required is 10-50 ng/Õl. 

Preparing PCR 

The Y Chromosome Microdeletion Detection Kit has been optimized for use with 

the Perkin-Elmer GeneAmp PCR System 9600 or 9700. 

1. Prepare 1 PCR tube for each sample and external control. 

2. Thaw vials to be used and mix thoroughly by vortexing for a few minutes. 

3. Aliquot PCR Mix into each PCR tube as shown in the table below.  

Component Volume 

PCR Mix  10.0 Õl 

Primer Mix 10.0 Õl 

Taq. Pol. 0.5 Õl 

Total 20.5 Õl 

 4. Add 5.0 Õl of DNA (10ï50 ng/Õl) to each PCR tube. 

Starting the Reaction 

Transfer PCR tubes to a PCR machine and begin thermocycling with the 

following program: 

Stage Description Temp. Time 

1 Activation 95 ÜC 10 min. 

 

2 

Amplification 

35 cycles 

95 ÜC 45 sec. 

58 ÜC 1 min. 

72 ÜC 1 min. 

3 Final Extension 72 ÜC 7 min. 

4 Hold 4 ÜC Indefinite Hold 

Note: For the GeneAmp PCR System 9600, the heat/cool rate is 2.3 oC per second whereas it is 5 oC 

per second for the 9700. When the GeneAmp PCR System 9600 is used, the peak heights will be too high, 

making analysis difficult, therefore the injection time should be decreased to a minor value (min/sec) to 

display normalized peaks when the samples are loaded onto the Genetic Analyzer (See Sec.6).  
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Section 5: Electrophoretic Detection and Data Analysis 

Performing Capillary Electrophoresis with an ABI Genetic Analyzer 

1. Prepare the necessary amount of size standard for all samples to be analysed 

by combining:  

To run samples on 3100, 3100 Avant, 3130xL, 3730xL, 3500xL Genetic 

Analyzers: 

¶ 10Õl Hi-DiÊ Formamide  

¶ 0.3 Õl GeneScanÊ-500 LIZÊ 

To run samples on the 310 Genetic Analyzer: 

¶ 20 Hi-DiÊ Formamide  

¶ 0.5 Õl GeneScanÊ-500 LIZÊ 

2.  For 3100, 3100 Avant, 3130xL, 3730xL, 3500xL Genetic Analyzers: 

Use 10 Õl of this mix to inject 1 Õl of PCR products collected in the same tube. 

For the 310 Genetic Analyzer: 

Use 20 Õl of this mix to inject 1.5 Õl of PCR products collected in the same tube. 

3. Create Plate Sample Sheet using the Data Collection Software:  

¶ Select the appropriate Result Group. 

¶ Select the appropriate Instrument Protocol for 3100, 3130 and 3130xL, 

3500xL instruments, or the appropriate Run Module for 310, using the 

following specifications: 

Instrument Type Run Modules and Conditions References 

3130/3130xL 

3500xL Analyzer 
FragmentAnalysis36_POP7_1,  

Dye Set G5 

ABI PRISMÈ 3130/ 

3130xl, 3500xL Genetic 

Analyzer Userôs Manual 

3100 Analyzer 
FragmentAnalysis36_POP7_1, 

Dye Set G5 

ABI PRISMÈ 3100/3100-

Avant Genetic Analyzer 

Userôs Manual 

310 Analyzer 

GS STR POP4 (1mL) G5 v2.md5 

Injection condition: 15 kV/5 sec 

ABI PRISMÈ 310 

Genetic Analyzer Userôs 

Manual 
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Data Analysis with GeneMapperÈ Software v5.0 

Preparing the Software for Analysis 

¶ Double click to open GeneMapper software on desktop. 

 

 

 

 

 

 

 

 

 

 

¶ Login with User Name and Password to access the software. 
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¶ To import the panels from the CD provided with the kit, select Tools > 

Panel Manager.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Select Panel Manager. 
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¶ Click File > Import Panels. 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Select GML_YdEL_Panels and click Import. 
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¶ To import the binsets from the CD provided with the kit, click on 

GML_YdEL. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶  Click File > Import Bin Set. 
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¶ Select GML_YdEL_bins and click Import. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Click Apply and OK. 

 

¶ To import the other parameters from the CD provided with the kit, select 

Tools > GeneMapper Manager.   
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¶ On the Analysis Methods tab, click Import. Choose GML_Ydel_anl file 

and click Import.  

 

¶  

 

 

 

 

 

 

 

 

 

GML_ CVD-1 Panel_anlys file for Analysis Methods 

GML_ CVD-1 Panel_rep file for Report Settings 

GML_ CVD-1 Panel_size file for Size Standard 

GML_ CVD-1 Panel_tbl file for Table Settings 

GML_ CVD-1 Panel_plt file for Plot Settings 

 

 

 

 

 

¶ Import the other files below in the same manner: 

On Table Settings tab: GML_YdEL_tbl 

On Plot Settings tab: GML_YdEL_plt 

On Report Settings tab: GML_YdEL_rep 

On Size Standard tab: GML_YdEL_size 

 

¶ Click Done.  
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¶ To open a New Project, click on the icon     and choose Microsatellite. 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Click OK.  

¶ Click on the icon     , to Add Samples to Project. 

¶ Choose the pathway for the run files, click Add to List and Add. More 

samples can be selected with CTRL button on keyboard.  
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¶ To change the Table Settings, open Table Settings tab and select 

GML_YdEL_tbl in the drop-down list. 

 

¶ Select GML_YdEL in the drop-down lists under Analysis Method, 

Panel and Size Standard as indicated below.  

Analysis Method: Select GML_YdEL_anl 
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Panel: Select GML_YdEL 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Size Standard: Select GML_YDEL_size 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Select all of the boxes by holding left mouse button and pressing CTRL+D 

buttons on keyboard. 

¶ Click on the Analyze icon. 


















